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ATF Power Toolkit

The ATF Power Toolkit was created to help power users get the most out of the Armored Task Force game
engine.  It allows you to create new maps and change or create new databases for the ATF Scenario Builder
to use in creating scenarios.  The Toolkit did not ship with the original version of Armored Task Force but is
installed automatically with all upgrades to ATF, version 1.02 or later.  To get the latest upgrade, go to
www.prosimco.com. 
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1. How to Open a Database

A scenario database holds all of the reference information on which the scenario is built.  It contains all of the
information about the vehicles, ammunition, and weapons in the scenario.  It also contains all of the sounds and
graphics for all of the units and hierarchies in a scenario.

Creating a new database from scratch is a huge undertaking and, really, beyond the scope of this tutorial.  In
this tutorial, we will make changes to the existing Armored Task Force database. This is usually the best way
to attack just about any mod you want to make to the game.

1-1. Select the database:

All changes to an Armored Task Force database are made using the ATF Power Toolkit. To continue with
the topics in this tutorial, you must open this application.  The ATF Power Toolkit did not ship with the original
version of Armored Task Force, but is included with all of the free upgrades, beginning with the version 1.02
upgrade.  You can get the latest upgrade free at www.shrapnelgames.com.

1. Select the 'Open...' function from the 'Database' menu in the ATF Power
Toolkit. 
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2. Select the database you
wish to make changes to.
'database1.dbs' is the
default database for
Armored Task Force
and is a protected file
name.  After you make
changes to this database,
you will have to save it
with a new name.  For
more information, see
'Save a database'.

2. How to Create a New Piece

A piece is a multi-framed image that depicts multiple aspects of a single object.  It is used to display a graphic
representation of a vehicle on the game map. 

This topic demonstrates how to create a piece and add it to a database.  To actually make a piece correspond to
a vehicle, you must edit the vehicle.  For more information on this, see 'Create a new vehicle'.

2-1. Create the graphics:

The first step is to create the image that will be displayed on the screen.

1. using your favorite drawing application, create a
single image of the graphic.  If the vehicle has a
turret or a propeller (as is the case with our piece),
you must put the axis of rotation of the graphic at
the center of the image.  The background for the
image must be 'magenta' (red = 255, blue = 255,
green = 0) in order for it not to appear as part of
the image when drawn on the screen.
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2. We are also going to draw the propeller,
as a separate image.  Again, we are going
to center the axis of rotation of the image
in the center of the image so that it will be
drawn properly on the screen.

3. We are going to increase the size of the image and copy and rotate it to create frames. 
The first frame must point north. The other frames should be rotated by equal angles,
completely through 360 degrees (the last image should be rotated to the left by a distance
of the rotation angle from the first frame).  It is very important that this rotation be done
without blending the background color into any of the images. Otherwise, an ugly pink
border will surround the image when it is drawn in Armored Task Force.  The number of
frames is not set. You can use any number of frames, as long as they are each rotated by
an equal angle.  But the more frames you use, smoother rotation of the image will be.  We
are going to repeat this step for the propeller image. Both images should be saved in the
'Data' subdirectory of the Armored Task Force install directory.  The width of the frame
should not exceed 640 pixels wide.  There is no limit on the height of the image.
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2-2. Add the piece to the database:

Now that we have built the image, we need to add it to the database.  We need to start the ATF Power Toolkit
application and open a database to continue.

1. Select 'Add Piece...' from the
'Pieces' sub-menu of the 'Database'
menu.

2. Select the image file for the piece you
want to add to the database.
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3. Input the name that you will use to reference the
piece inside the database.  This is the name you will
input when prompted for a piece name in the Vehicle
Edit dialog in order to display the piece.

4. You must tell the database how many frames wide
and high the source image is, as well as how many
total frames are in the image.

5. You need to tell the database whether this is an
enemy piece.  If you select 'Yes' the piece will be
added as an enemy piece. Selecting 'No' will
designate this as a friendly piece.  Armored Task
Force uses this data to decide whether the player
is playing as 'Red' or 'Blue' during a game.  If more
than half of the player's vehicles are 'Red', icons
and dots on the Overview Map will be displayed as
Red during game play. 

3. How to Add a Vehicle to the Database

A vehicle object in the database contains all of the data defining a vehicle type, including its special capabilities,
its starting ammo, its speed and dimensions.  Each unit in the game refers to a vehicle in the database and
derives its capabilities from the vehicle object in the database.

We are going to build a UH-60L by copying an OH-58D to a new vehicle object and changing its attributes.  You
can also make a vehicle by starting from scratch, but you must then manually input all of the Kill Odds data for
every weapon in the game.  This is not the preferred method for creating a vehicle.

3-1. Create a vehicle:

We are going to build a vehicle by copying an existing vehicle to a new vehicle object.  Then we are going to edit
the copied vehicle to reflect the properties we want it to have.
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1. Select the 'Copy...' function from the 'Vehicle' sub-menu of
the 'Database' menu in the ATF Power Toolkit.

2. Select the vehicle you wish to copy.
Ideally, you select a vehicle which has
similar vulnerabilities to direct fire
weapons.  Kill Odds are time consuming to
edit, so if you can start with a close match,
you will save time.

3. Select 'No'.

4. Select a name for your new vehicle.
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5. Fill in the edit boxes for
the vehicle data.

· Speed.  The speed of
the vehicle during
normal movement. 

· Sprint Speed.  The
speed while under the
'Sprint' Order. 

· Reverse Speed, Turn
Speed, Turn Radius. 
Currently not
implemented. 

· Target Value.  Used by
the AI to select targets
for direct and indirect
fire. 

· Threat Value.  Used by
the AI to select targets
for direct and indirect
fire. 

· Weight.  Currently not implemented. 

· Height, Length, Width.  Dimensions of the vehicle.  If the vehicle has a turret, these dimensions are not
included in this total. 

· Time to Move.  How long it takes for a unit to start moving after the unit's 'Stop' Order is canceled. 

· Time to Enter Defilade.  How many seconds it takes a unit to enter defilade after the 'Defilade' Order is
given. 

· View Range.   This is the base range at which a unit will detect other vehicles.   It is affected by vehicle and
target movement and posture. 

· Protection Value.  A value from 1-100 which indicates how susceptible occupants are to suppression (lower
number means easier to suppress). 

· NBC Detect.  A number from 1-100 which indicates how good the vehicle is at detecting chemical agents. 

· BOS (Battlefield Operating System) Flags.   Check all of the boxes which describe the function of your
vehicle.  These attributes are used by the game AI to decide how to fight this vehicle type as part of
Missions. 
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Finally, we delete the old weapon and click 'Add' to add a new weapon to the vehicle.

6. Go back to the image for your
new vehicle in whatever drawing
program you prefer and try to
identify the location of weapons
on the image.  This is the place
from which weapons bursts will
be shown when the vehicle is
firing.  On a tank, this might be
the turret muzzle, but on our
aircraft, this is the door gun. 

The value you need is from the
center of the vehicle (with up
being the positive Y axis and
right being the positive X axis). 
In other words, you need to
subtract the coordinates of the
center from the coordinates of
the weapon location and then
multiply the Y value by -1
(huh?). 

This number will be input into
the Flash Offset X, and Y for the
aircraft.   Right now, flash
graphics are not implemented. 
But this may change someday
as the Armored Task Force game engine is upgraded, so it is a good idea to input this value so that your
vehicle and database will remain 100% compatible when the engine is upgraded.

7. We were presented with
this dialog when we selected
the 'Add' button from the
vehicle dialog.  If this were a
vehicle with a turret, we
would add the weapons to
the turret, not here, unless
they were connected to the
chassis of the vehicle, but
our aircraft does not have a
turret. 

Click on the 'Weapon' button
and select the weapon, and
then fill out the form. 

· Ammo.  Total number of
rounds the vehicle
carries as its basic load
for this weapon. 

· Left, Right Limit.  These numbers describe the left and right extent of the weapons traverse.  Enter -99 if
there is no limit.  Directions are described with zero being straight ahead and 0 to -3200 being to the left of
straight ahead and 0 to 3200 being right of straight ahead.  Our door gun only fires to the right of the
aircraft. 

· Flash Offset X, Y.  This is the number we just got from the image in the last step. 
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· Suppression Radius.  This is the radius that can be suppressed on the ground with this weapon when the
unit has the 'Suppress' SOP set. 

· Percent Infra-Red.  A value from 1-200.  This is how well the vehicle sees in infrared (used when looking
through smoke). 

· Percent Night Vision.  A value from 1-200 describing how well the vehicle can see during limited visibility
(night). 

· Co-Axial.  If checked, this weapon is fixed to either the chassis or the turret of the vehicle which it is a part. 
If this is the case, the vehicle or turret will be rotated when the weapon engages targets. 

· Shoot Moving.  If checked, this weapon can be fired while the unit is moving. 

8. We are going to delete
the special attributes that
do not apply to our
aircraft.  Then, we select
the 'Rotary Wing' item
and select 'Edit' so that
we can tailor it to our
aircraft.
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9. First we fill out the form: 

· Altitude.  The height above ground level at
which the vehicle flies while moving normally. 

· Sprint Altitude.  The altitude at which the
aircraft flies when sprinting. 

· Defilade Altitude, Defilade Popup.  If defilade
popup is checked, then when the vehicle is in
defilade, it will fly at the 'Defilade Altitude'.  

· Land When Stopped.  Self-explanatory.  This needs to be checked if we have troop carrying aircraft (which
we do). 

Now we are going to change the propeller graphic...

10. Select the UH-60L propeller graphic that
you drew using your favorite drawing
application.

11.  After we click 'OK' on the
Rotary Wing Attribute dialog,
we are going to select the
'Add..." button and select
'Personnel Carrier' so that our
aircraft can carry soldiers. 

We simply fill out the form. 

Time to Open.  The amount of
time required to open the
vehicle to accept dismounts. 
This is most applicable to APC's
and other vehicles with large,
heavy back ramps. 

· Time to Mount.  How much
time, per dismount team,
is required to load the
aircraft with the team and
its equipment? 

· Time to Dismount.  Time
to unload all of the
dismount teams aboard an
aircraft. 
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· Time to Close.  After mounting or dismounting is complete, how long it takes to close the carrier. 

· Max Number of Dismount Teams.  Self-explanatory. 

· Open Graphic Piece.  You can create a separate graphic piece to display the vehicle while it is open and
specify it here. 

12. Now we will specify the
graphics which represent the
vehicle on the map.  First, we
will specify the NATO icon
which represents the vehicle
by selecting the 'NATO Piece'
button...

13. ...And specifying the rather generic
'Friendly Aviation Blue'.
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14. Now we are going to
pick the graphic piece we
created so that, when we
have selected 'Vehicle Icons'
in our 'View Options'
window, our new graphic
piece will be displayed. 
Select 'Graphic Piece' and
then select the 'UH-60L'
graphic that we created in
the previous topic.

15. If you wish to change the vulnerabilities of the vehicle to direct fire weapons, you can do so by selecting 'Kill
Odds'.  You will be presented with the 'Weapon Kill Percentages' dialog which allows you to change the pK
(percent kill, odds a weapon will kill the vehicle if hit) for each weapon in the database. 

pK is separate from pH (percent hit,
the odds a weapon will hit a
vehicle).  pH is based on a
complicated algorithm and can not
be directly edited in the database. 
It relies on vehicle movement,
visibility, weapon magnifications,
and many other factors. 

Here is how to use the dialog. 

· Front, Back, Left, Right.  These
are the odds (from 1-100) that
a hit on this facing with the
specified weapon will destroy
the vehicle. 

· Top.  This value is not currently
implemented, but it is a good
idea to fill it in so your database
will continue to be compatible
when the Armored Task
Force game engine is
upgraded, later. 
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· Back, Next.  Cycle through all of the weapons in the database. 

You can also edit these values by using the 'pK List' functions, 'Import' and 'Export'.  With these functions and a
program like Microsoft Excel*, you can export all of the current database values, edit them in a tabular format,
save them as a comma-separated value list, and import them back into the game.

16. You can also edit the
vulnerability of your vehicle to
indirect fire, by selecting the 'IF
Effects' button. 

These are base pK's (percent kills,
odds, from 1-100, that a vehicle will
be killed) used if the vehicle is within
the blast radius of an indirect fire
impact.  They are modified by the
caliber of the weapon (a rocket will
have higher odds than these, while a
mortar will have lower odds).  The
base value here is for a U.S. 155mm
round. 

· HE.  High explosive rounds. 

· DPICM.  Dual-purpose,
improved, conventional
munitions (bomblets). 

· NUKE.  Nuclear rounds. 

· PGM.  Precision guided
munitions (laser guided, 'smart' munitions. 

· CHEM.  Chemical munitions effects.  The odds the vehicle will die when first entering a chemically
contaminated area. 

4. How to Save a Database

When you make changes to a database, you must save them so that the
changes are not lost. However, the file 'Database1', and its associated Piece
List, Vehicle List, Weapon List, and Sound List are protected, so, if you make
changes, you must save them with a different name.

4-1. Save the database:

1. Select the 'Save' functions from the 'Database' menu in the ATF Power
Toolkit. If you have opened the original Armored Task Force database,
you will be prompted to provide names for the various pieces of your new
database. We recommend using the same file name, with different
extensions, for your database components, so you can easily discern what
pieces go to your database.  It is also not a good idea to give your database
the same name as one of your custom scenarios, as it will be hard to
distinguish your database files (which can be used in multiple scenarios)
from the scenario files which apply only to your scenario.
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2. To use your database in a scenario, after creating a new scenario using ATF Scenario Builder, select
'Import Database' from the 'File' menu. When, prompted, select your database and you will be all set! Your
database will be loaded into the scenario.

5. How to Create a New Map

One of the most distinctive features of Armored Task Force is its ultra-realistic maps, made from real, GIS
topographic data of real locations across the world.  Now, with the ATF Power Toolkit, for the first time in any
ProSIM Company product, you can build and add your own topographic maps.

The capability to import USGS format DEM's is a highly advanced feature, and well beyond the scope of this
Tutorial.  It requires an advanced understanding of cartographic principals and GIS data formats.  Should you
want help doing this, contact us on our web forum?  In this tutorial, we will begin with topographic data in the
custom, ProSIM Company XDM format.  You can download free XDM format data at the Armored Task
Force game board, at the web forum.

In this tutorial, we are going to try to, as closely as possible, exactly recreate the terrain around Bihac, Bosnia-
Herzegovina.  If you wish to create a map without exactly replicating real terrain, you can skip several of the
steps in this topic.  These steps are indicated as they arise.  In order to recreate real terrain you will also need a
1:50,000 or 1:100,000 map of the terrain you wish to replicate.  The map (military maps work best) needs to
indicate UTM (Universal Transverse Mercador) coordinates, as well as any trees, roads, or other special terrain
which are present on the actual terrain.

5-1. Create an Elevation Map:

Building Armored Task Force maps requires the ATF Power Toolkit. To continue with the topics in this
tutorial, you must open this application

1. Select 'New Elevation Map' from the 'Map'
menu in ATF Power Toolkit.
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2.  You will be prompted for an XDM from
which to make the map.  If you wished to
create a map from a USGS format DEM,
you could change the entry in 'Files of
type:' to load a DEM.

3.  TO EXACTLY RECREATE REAL TERRAIN ONLY.  Go to the margin
information of your 1:50,000 or 1:100,000 map of the terrain and look
for the 'Magnetic Information'.  We need to extract the true north (TN) to
grid north (GN) angle in mils.  A clockwise angle is positive.  A counter-
clockwise angle is negative. 

Also, from the margin information, you need to extract the two letters,
100,000 meter grid zone designators for the map.

4.  TO EXACTLY RECREATE REAL TERRAIN ONLY. Next, we need to figure out how
many meters there are in an arc-second of longitude.  We need to find tick-marks
along the bottom of the map which indicate minutes of longitude (there are sixty
arc-seconds in an arc-minute).  We are going to measure the number of meters (in
map scale) between these tic marks.  Then we are going to divide the number of
meters by the number of seconds (minutes X 60).  This will give us the number of
meters per arc-second of longitude.
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5.  TO EXACTLY RECREATE REAL TERRAIN ONLY.  We need to find the
bottom left corner of the map.  It needs to be at a location where we can
determine both the longitude and latitude AND the UTM grid.   

We also need to look at the map and decide the size of the map in meters
high and wide.  A map of a region like Bihac, with lots of trees and
mountains, will bog down the engine if it is much larger than 20 X 20
kilometers.  A map of wide open terrain like Saudi Arabia can be much
larger.  The maximum map size is 50 X 50 km.

6.  You will be presented with the 'Map
Production Information' dialog, which allows
you to tell the Power Toolkit how to extract
data from the XDM data file you have selected.

TO EXACTLY RECREATE REAL TERRAIN
ONLY.  Enter the numbers you have extracted
from steps 3-5.

· Long.  This is the longitude of the bottom
left corner of the map, in seconds (there
are 60 seconds in a minute and 3600
seconds in a degree).  Negative values are
west (of Greenwich, England) and positive
values are east. 

· Lat.  The Latitude of the bottom left corner
of the map in seconds.  Positive values are
north (of the equator) and negative values
are south. 

· The easting of the UTM eight-digit grid of
the bottom left corner.  In an eight-digit
grid, the ones column represents tens of
meters. 

· The northing of the UTM grid. 

· Width.  The horizontal size of the map in tens of meters.  The max is 5000. 

· Height.  The vertical size of the map in tens of meters.  Again, the max is 5000. 

· Appearance. These settings decide the color of the color map when it is drawn. 

· Desert.  Light-tan. 

· Rocky.  Red-brown. 
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· Grassland.  Green. 

· Frozen.  White. 

· Alpha.  This is the rotation angle between the absolute axes of the XDM file from which you are extracting
data and the data axes of the map you are creating. Clockwise is positive, counter-clockwise negative.  TO
EXACTLY RECREATE REAL TERRAIN ONLY.  This is the True North-Grid North angle from step 3. 

· m/sec.  How the XDM data is "stretched" horizontally to make the new map.  TO EXACTLY RECREATE REAL
TERRAIN ONLY.  The number of meters per arc-second of longitude from step 4. 

· Grid Zone Designators.  The two letter designator in front of the UTM grids that are displayed for the map. 
The bottom left entry is always used.  The other values are only used when the easting and/or northing
exceeds 9999.  On real maps, the second letter of the grid-zone designator increases as you move north,
and the first letter increases as you move right.  TO EXACTLY RECREATE REAL TERRAIN ONLY.  The
100,000 meter grid-zone designators from step 3. 

7.  This preview map indicates the orientation of your new map in
the XDM map set.  TO EXACTLY RECREATE REAL TERRAIN ONLY. 
Do not click in this map!  Doing this will alter the settings you
have made in the previous step and make your map inaccurate.

8.  ATF Power Toolkit builds three
components.  A color map, a contour
map, and an elevation map.  However,
the contour map and color map must be
converted to DX maps (a ProSIM
Company custom format) before they
can be imported into an Armored Task
Force game map.  
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First, you are prompted to provide a name for saving the temporary color map that you will then convert to a DX
map.

9.  Provide a name for the
custom map.  The map
must reside in the 'Data'
sub-directory of the
Armored Task Force
install directory in order to
be converted by the
Power Toolkit.

10.  The contour interval is the vertical difference between contour lines on the contour map.  Contour lines
connect points of equal elevation on a map.  This value is entered in tens of meters.  For flat terrain, you may use
'1'.  For mountainous terrain, you may use anywhere from 2-4.  The intent is that the contour map not be so
saturated with contour lines that it is unreadable.

11.  You must also specify the name for the
temporary contour map.

12.  Again, it must be in the 'Data' sub-
directory of the Armored Task Force
install directory.
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13.  Next, we must save the elevation
map.  We recommend that you save all
of the final map components with the
same file name and different extensions. 
This makes it easy to identify what maps
go with what components.  This file
must also be in the 'Data' sub-directory
of the Armored Task Force install
directory to be useable.

5-2. Convert Graphic Maps to DX Format Maps:

The maps drawn by the ATF Power Toolkit are normal Windows bitmaps.  In order for them to be used by
Armored Task Force in game maps, they must be converted to a custom ProSIM Company format called DX
format.  The format is still a Windows bitmap, but the map is cut up into rectangular sections that can be
digested by the Armored Task Force graphics engine.

1.  Select 'New' and 'DX Convert' from the 'Map'
menu.

2.  Select the bitmap which you wish to
convert to DX format.
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3.  Select a name with which to save the
converted file.  Again, we recommend using
a name similar to that of the other map
files, so that it will be easy to find later.

4.  The .map file is linked to the DX format
map file.  It basically tells Armored Task
Force how many blocks a DX format file
has been chopped into.  Again, we
recommend a common name with the other
game map files.

5.  ATF Power Toolkit will tell you how many tiles and of
what size it has chopped the map into during the conversion.
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6.  The .gmp (game map) file is the top
level file for an Armored Task Force
map.  When you select a map to import
into Armored Task Force either from
the scenario wizard or the 'Import Map'
functions, you select a .gmp game map
file.  Select a name for the game map
which corresponds to this map file.

7.  ATF Power Toolkit is done with the conversion.  It asks you if you
want to load the game map.  Say no, because we have some more work to
do first.

8.  We have completed conversion of the color
map.  Now, we are going to repeat the process
to convert the contour map to DX format.

9.  Select the temporary contour map
image.
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10.  Select a name with which to save
the contour map.

11.  All images of the same size will always
be chopped into the same number and size
of tiles.  Since our color and contour map
are both the same size, we can save over
the original .map file.

12.  We can also save over the .gmp
game map file, since we are going to edit
it next, anyway.
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5-3. Edit the Armored Task Force Game Map:

The only thing left to do is gather all of the pieces we have built into an Armored Task Force game map.  The
game map (saved in the .gmp file) 'points' to all of the components that make up the game map.  In order to
continue with this topic, we will assume you have already loaded a game map, either by responding 'yes' to the
prompt to do so during the map creation process, or by using 'Open' from the 'Map' menu.

1.  Select 'Edit' from the 'Map' menu.

2.  You will be presented with the 'Edit Game Map'
dialog.  Enter the name of each file which makes up the
game map.  For a game map to function correctly in
Armored Task Force, it must have an entry in every
block except 'AI Help Map'.  However, unless you have a
map of completely open, completely flat desert,
hierarchies will not be able to execute formations or
Missions correctly without the help map. 

3.  To use a file dialog to
select files, click on a
'Browse' button.  Select
the file name for the file
you wish to include in each
entry.  All of the specified
files must be in the 'Data'
sub-directory of the
Armored Task Force
install directory for the
game map to load
properly. 

Make sure you save the
map using 'Save' from the
'Map' menu before
continuing.
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6. How to Add Terrain to a Map

In addition to the elevation data they contain, the elevation map component of an Armored Task Force game
map also contains all of the special terrain (trees, roads, water, and urbanization) for the ATF game map. This
terrain impedes or aids movement and visibility and creates a tough, complex battlefield for Armored Task
Force players who will play your scenario.

There are two components which make up the terrain you see on the Armored Task Force map. The first is
the Terrain Type List and the second is the Terrain List (again, both are saved as part of the .emp, Elevation
Map file). The Terrain Type List is like a database that contains all of the information about the different terrain
types on the map and how they interact with units and are drawn on the screen. The Terrain List is the actual
terrain objects on the map, each of a type described in the Terrain Type list.

6-1. Load Terrain Types:

While you can start from scratch and build a brand new Terrain Type List, why? Armored Task Force ships
with a ready-made list that you can use in your own maps. Once you load this list, it becomes part of the
Elevation Map.  So, making changes to the Terrain Type List after you have imported it will not alter the Terrain
Type List provided with ATF.

1. Select the 'Open...' function from the 'Terrain Types' sub-
menu of the 'Map' menu in the ATF Power Toolkit. 

2. You will be prompted for the name of
the list file to load. 'atf1.ttp' is the file that
ships with Armored Task Force, and is
the foundation of all maps that ship with
ATF.
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6-2. Add Terrain Objects to the Map:

Now that you have the Terrain Types loaded into your Elevation Map, you can draw terrain objects on the map.
If you are recreating real terrain, you will need to be very careful to replicate the location of trees, roads, and
rivers. But, if you are creating a map from your imagination, it is only important to capture the 'feel' of a real
map. Rivers run in low ground, and roads generally follow contours to minimize grades.

It is not a good idea to overlap terrain. While it will not 'break' Armored Task Force, it will almost certainly
create unanticipated effects. It is better to draw terrain adjacently. Check out some of the current Armored
Task Force maps to see the best design practices in action.

1. First, initiate a new terrain object by selecting 'new' from the
'Terrain' sub-menu of the 'Map' menu.

2. Select the type of object you wish to create.
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3. Begin left-clicking on the
map to indicate outline of
the terrain object you are
creating. For streets and
rivers you will have to draw
the complete outline to get
a realistic effect.

4. When you are done drawing the terrain object, right-click to complete
the object. The Power Toolkit will connect the first and last point to
close the object. That's it! Repeat these steps until you have added all of
the terrains you wish to add.

7. How to Create Advanced Map Effects

In this portion of the tutorial, we are actually going to share with you how we create the 'look' of an Armored
Task Force game map.  These techniques will help your create maps that are both visually appealing and more
effective in communicating terrain the player.

But beyond this, these techniques will also improve the performance of your map in Armored Task Force. 
Drawing terrain objects at runtime eats a lot of processor power.  By using these techniques, you can eliminate
the need for Armored Task Force to draw terrain objects to indicate their location on the map.  This means
better performance and less lag during game play.

You should not execute the techniques in this topic until you are sure you have added all of the terrain to the
map that you want.
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7-1. Change Terrain Types for Color Replacement:

We want to make the terrain appear as solid color blocks when the color map is displayed.  We do this so that
we can use color replacement to insert our own graphics on the color map.  We will repeat these steps for every
terrain type in the Terrain Type List.

1. Select 'Edit' from the 'Terrain Types' sub-menu of
the 'map' menu.

2. We are going to select every single terrain type
in the Terrain Type List and change the way it is
drawn.
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3.  In each 'Terrain Type' dialog, ensure that the 'Color'
button and the 'Solid' button are selected, and that the
'Outline Invisible' button is unchecked.   

We also need to ensure that all of the terrain types have
unique colors specified for their 'Color' representation (if
you need to change a color, select 'Colors...').

7-2. Build an Export Map Image:

The next step is to create an export map.  A good export map indicates where terrain is on the map, so that you
can replace it with your own, more attractive and descriptive graphics.  Essentially, what we are doing is
converting the map from DX format (see Creating a New Map); back into a normal Windows bitmap, but with all
of our special terrain drawn on it.

1.  We want to create an export map of
just the color map, so we select 'Color'
from the 'Map' sub-menu of the 'View'
menu.
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2.  Second, we select 'Export Map' from
the 'New' sub-menu of the 'Map' menu.

3.  We are prompted to enter the name of
the export map.  It is best to save the map
in the 'Data' sub-directory of the Armored
Task Force install directory, since it will
need to be there later, when we convert it
back to DX format.

7-3. Edit the Export Map Image:

Prior to this step, we need to create graphics panels.  These are bitmaps with graphics patterns representing
trees, urban terrain, roads, and other terrain types.  Each panel should be the same size as the export map for
best results.  We need one panel for each terrain type on the map.  We assume this is completed before we
continue.

We are just showing you how WE created maps for Armored Task Force.  You can use any technique you
want to modify or improve the style of the map.

1.  Open 'Paint', the drawing program which ships with every version of Windows.  After we have opened it, we
are going to open our export map.
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2.  After the export map is open, in Paint, we select 'Select All' from the
'Edit' menu...

3.... And then 'Copy', also from the 'Edit' menu.  

4.  The whole export map is now
stored in the clipboard.

5.  We need to select the color of the terrain we want to replace as a
custom color in the colors menu at the bottom of the Paint window. 
First, we select the 'Select Color' tool from the toolbar and then we
select the color of the terrain we wish to replace by left-clicking on it
in the image.
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6.  Select 'Edit Colors' from the 'Colors' menu.

7.  Select the 'Define Custom Color' button...

8.  ...And then the 'Add to Custom
Colors'.
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9.  Next we are going to open the bitmap
panel we built which corresponds to the terrain
we want to draw on the map.  We select
'Open' from the 'File' menu and select our
terrain panel (which will represent the terrain
type on our modified map).

10.  We select 'Edit Colors' from the 'Colors' menu again.

11.  We double-click on our defined custom color and select 'OK'.

12.  Now our custom color appears on the color bar.  We are
going to right-click on it so that it appears as the background
color.  

34



13.  We want to cancel the 'Draw Opaque' function (so
that the background color will not be drawn on pasted
images) by selecting it in the 'Image' menu.

14.  Now we are going to paste our export map (stored in the
clipboard) over the panel.  All of the places on the export map
where the selected terrain is will be replaced with the graphics
from our panel.

15.  Now we save the resulting, composite image over
our old export map using 'Save As' from the 'File' menu
(make sure you don't save over your panel by accident;
you may want to use it again for other maps). 

We are going to repeat these steps for every terrain
type which appears in the export map, until we have
replaced all of the solid-colored blocks with more
visually appealing terrain.
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7-4. Import the Export Map Back into the Game Map:

We have finished modifying the export map, adding all of the graphics we want to appear on the finished map. 
Now we must make it usable by ATF (converting it to DX format).

1.  Select 'DX Convert' from the 'New' sub-
menu of the 'Map' menu.

2.  Select the export map.

3.  Select the old, DX-converted color map
file.  When ATF asks you if you want to
overwrite this file, answer 'Yes'.
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4.  We can overwrite the 'bihac.map' file. 
Remember that all images of the exact same
dimensions make exactly the same number
and sized tiles (see Create a New Map).

5.  However, we cannot overwrite the game
map (.gmp) file for this map.  It contains
pointers to all of the files in our game map
and we will have to recreate it if we overwrite
it.  So, when prompted, just save our new
game map with a temporary name and delete
the file as soon as we are done.

6.  To see our map, we have to reopen the game map, so that the color map will
be re-loaded into memory.   Select 'Open' from the 'Map' menu.
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7-5. Make Terrain Objects Invisible:

Wait a minute!  What happened?  We have changed the map but it still looks the same?  We have to tell
Armored Task Force not to draw the terrain itself, so that our handiwork can shine through.

1.  We are going to have to edit every terrain type again. 
To save ourselves work, we are going to get a head start on
the next step, which is exporting our contour map with the
terrain drawn on it.  Select 'Edit Terrain Types' from the
'Map' menu.

2.  We are going to select each terrain
type, from top to bottom.
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3.  First we are going to select the 'Color' button, select
'Invisible' and 'Outline Invisible'.  This will prevent
Armored Task Force from drawing Terrain Objects of
this type on the map.

4.  Then, we are going to select the 'Contour' button and
select the pattern and color which we want to use to
represent the Terrain Type on the contour map.   

So that our graphics can show through the contour map
when using the 'Contour Over Color' view, we recommend
using line patters rather than 'Solid'.  We also recommend
using a different color for every terrain type, even if they
have different patterns.  It makes it easier to identify these
terrain types at a glance.
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7-6. Making Terrain Permanent on the Contour Map:

We are going to create an export map of the contour map as well and re-import it into Armored Task Force. 
But we are not going to edit or make any changes to the export map before we import it.  Why do we do this? 
If you have a lot of graphics on the contour map, when it is shown over the color map (when the 'Contour Over
Color' view is active), the added graphics will block out the color map.  We want all of the terrain to be
transparent, so that you can see the color map beneath (see previous step).

Why bother?  If we are not going to change the contour map, why execute this step.  It’s simple.  Drawing all
that terrain on the map takes ATF a lot of processing power.  That causes lag and slows down game play.  If we
make the drawings on the map permanent, and prevent ATF from drawing the graphics, we will speed up the
game.

1.  We want to export the Contour map, so
we need to display the contour map.  Select
'Contour' from the 'Map' sub-menu of the
'View' menu.

2.  Now we select 'Export Map' from
the 'New' sub-menu of the 'Map'
menu.  When prompted, we save the
export map with a temporary file
name.  We can delete the file after we
complete this topic.

3.  We select 'DX Convert' from the 'New' sub-
menu of the 'Map' menu... 
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4. ...We select our export map... 

5. ...We choose to overwrite our old
contour map and answer 'Yes' to
overwrite prompts.  

6.  Again, it is safe to overwrite the
original .map object... 
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7.... But not the game map object (.gmp). 

8.  To see our map, we need to reopen it.  Select 'Open' from the 'Map' file... 

9.... And the game map files for this map
(.gmp). 
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7-7. Make Terrain Objects Invisible, Part II:

Finally, we have to tell Armored Task Force not to draw the terrain when the contour map is shown, either.

1.  Select 'Edit Terrain Type' from the 'Map' menu again.

2.  One last time, we are going to go through each
terrain type.  
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3.  This time, we are going to, for each terrain type;
select the 'Contour' button, and then 'Outline Invisible'
and 'Invisible'.  This will prevent Armored Task Force
from drawing this terrain type on the map.

8. How to Add AI Terrain to a Map

AI (Artificial Intelligence) Terrain is 'hints' that you give to Armored Task Force to help it make decisions.  ATF
uses this data to make decisions about formations, movement of units, and execution of Missions for enemy and
friendly hierarchies.  The AI Help Map is a list of AI Terrain objects (much as the Terrain List is a list of Terrain
objects).  There are four types of AI Terrain objects stored in the AI Help Map.

· Impassible Terrain Map.  This terrain object is actually a map 'overlay' which describes which spots on the
map is impassible to vehicular traffic.  It can only be generated automatically, by the ATF Power Toolkit's
automation features. 

· Regions.  These are manually drawn areas on the map, much like normal Terrain objects, which describe
regions that are impassible to certain types of traffic.  Regions are much more powerful than an Impassible
Terrain Map because ATF can use the region's bounding points to determine a path around the region. 
However, they take a very long time to create, even for the easiest of maps. 

· Routes.  Routes are user defined paths around and through restricted terrain.  They help ATF determine
how to pass through difficult regions on the map.  They are much more useful if they are drawn as short
segments that Armored Task Force can link together into a coherent path for units and hierarchies. 

· SBF's.  This stands for Support By Fire.  These are groups of points on the map which are favorable for
observation and fields of fire for different types of vehicles.  They can be drawn manually, but this is very
time consuming.  It is much easier to use the Power Toolkit's automation features to select them for you. 
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8-1. Make AI Terrain Visible:

In order to make changes to the AI Help Map, we must make it visible in ATF Power Toolkit.  The AI Help Map
is only visible in the Power Toolkit.  It can not be seen in the ATF Scenario Builder or Armored Task
Force.

1.  Select 'Options' from the 'View' menu.

2.  Ensure that the 'Show AI Help Map' box is checked.   
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8-2. Create and Save an AI Help Map:

What gives?  We made the AI Help Map visible.  Why hasn't the view changed?  Well, we don't have an AI Help
Map yet!  We have to create a map and begin adding AI Terrain objects before we will see the map.

1.  Select 'New List' from the 'AI Help Map' sub-
menu of the 'Map' menu. 

2.  We need to save the AI Help Map so that it is 'pointed
to' by the Game Map.  Select 'Save As' from the 'AI Help
Map' sub-menu of the 'Map' menu. 

Again, we suggest that you use the same name, with a
different extension that you use for all of the other map
components, so that it will be easy to identify that the file
is part of the map. 
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8-3. Auto-Generate AI Terrain Objects:

The first objects that we need to add to our AI Help Map are an Impassible Terrain Map and SBF's.  This is best
done using the auto-generate features of the ATF Power Toolkit.  For the auto-generate functions to work
correctly, these terrain objects must be created in this order.

1.  We are
going to make
an Impassible
Terrain Map. 
This can only
be generated
via the auto-
generate
function. 
Select 'Map',
'AI Help Map',
'Auto
Generate', and
'Impassible
Regions'.

2.  Now, with impassible
regions identified by blue
boxes, we are going to auto-
generate SBF's.  Select 'Map',
'AI Help Map', 'Auto
Generate', and 'SBF's'.
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8-4. Add Routes to the AI Help Map:

The last terrain objects we need to build are routes.  Routes help the Armored Task Force AI figure out how
to negotiate restricted terrain.  They work best if planned in short segments of a few kilometers in length.  The
AI can then 'tie them together' into a single route to where it wants to go.

Unrestricted, flat terrain may have no routes at all.  We have used an example of very mountainous terrain to
provide this example.

1.  Select 'New' from the 'AI Help Map' sub-menu of
the 'Map' menu. 

2.  Select 'Route'
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3.  Fill out the AI Terrain Route Data dialog. 

· Terrain Name.  Can be left blank. 

· Route Type.  Allows you to indicate for which
modes of travel the route is intended.  Rotary and
Fixed Wing are currently not implemented in the
ATF engine. 

· Width.  Tells the ATF AI what size formations may
pass through the route (0 will force a 'none'
formation). 

· Use at greater than 45 degrees.  Select this option if the route is through a completely restrictive obstacle
that can only be bypassed through this route (such as a bridge over a river).   

4.  After you select 'OK', just left click on each
point in the route.  It does not matter which
direction you plan the route in, as ATF will use the
route in reverse if it fits the desired path.  

Hit the 'Space' key when you are done planning
the route. 

5.  If you have multiple routes into and out of
restricted terrain, you should draw them all.  This
indicates to the AI that it can come at the terrain
from multiple directions.
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6.  When you are planning routes through a
restricted area (such as bridge over a river) that
can not be bypassed, make sure you select 'use
at greater than 45 degrees'.  This tells the
engine that it MUST use this route to get
through the terrain.

7.  Then plan
the route as
you do other
routes. 
Again, you
want to plan
multiple
routes
through the
terrain if it
has multiple
entrances
and exits.
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